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Duet-Breakout-Kabel

Duet–
Benutzerhandbuch

Apogee Software-CD

FireWire-Kabel (1 m)

Lieferumfang

Duet

Im Lieferumfang Ihres Duet-Pakets sollten 
folgende Teile enthalten sein: 

Duet•	
FireWire-Kabel (1 m)•	
Duet-Breakout-Kabel•	
Apogee Software-CD•	
Duet-Benutzerhandbuch•	
2 Audio-Adapter  •	
(1,4”-Monoklinke auf  
Cinch-Buchse) 
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Einführung in Duet

Ein- und Ausgangspegel
	 Diese LEDs zeigen 

den Pegel des mit dem 
Drehregler ausgewählten Ein- 

oder Ausgang an.
	

FireWire-Port
Schließen Sie Ihren Mac 
mit dem mitgelieferten 
FireWire-Kabel hier an Duet 
an. Das Gerät wird über 
FireWire mit Strom versorgt. 

Der Drehregler
Das Aussteuern könnte nicht 

einfacher sein. Drücken Sie den 
Drehregler, um einen Ein- oder 

Ausgang auszuwählen und 
drehen Sie den Regler, um den 

gewünschten Pegel einzustellen.

I/O Breakout-Kabel
Schließen Sie an das 
mitgelieferte Breakout-
Kabel Mikrofone, 
Instrumente und Line-
Geräte an.

Kopfhörer-Ausgang	
Schließen Sie hier Ihren  
Kopfhörer an.

Phantomspeisung
Diese LEDs leuchten, wenn 
48V-Phantomspeisung an den  

 -Anschlüssen anliegt.
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Kurzanleitung

Systemanforderungen

Macintosh G4 1GHz oder schneller, PPC oder Intel CPU, 1 GB RAM (mindestens), 2 GB 
(empfohlen), OS X: 10.4.11 oder höher; OS X 10.5.3 oder höher dringend empfohlen

Installation des Apogee  
Software-Pakets
Legen Sie die beiliegende CD in CD-
Laufwerk Ihres Macs, doppelklicken Sie 
das "Duet Software Installer"-Symbol und 
folgen Sie der Bildschirmführung. Nach 
erfolgreicher Installation ist ein Neustart 
erforderlich.

   

Anschluss des FireWire-Kabels
Nachdem der Mac neu gestartet wurde, 
verbinden Sie den FireWire-Port von 
Duet mit dem mitgelieferten Kabel mit 
einem FireWire 400-Port an Ihrem Mac. 

Falls Ihr Mac nur mit FireWire 800-Ports 
ausgestattet ist, verwenden Sie ein 
FW400-zu-FW800-Kabel. Beachten Sie, 
dass in diesem Fall der FW 800-Port mit 
FW 400-Geschwindigkeit überträgt.  

Da Duet über die FireWire-Verbindung 
mit Strom versorgt wird, sollte die OUT-
LED nun leuchten.

2
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Kurzanleitung

Auswahl von Duet für die  
Ton-Ein- und Ausgabe  
Ihres Macs 
Nachdem Sie Duet an Ihren 
Mac angeschlossen haben, 
erscheint das links abgebildete 
Dialogfenster. Klicken Sie Ja, 
um Duet für die Ton-Ein- und 
Ausgabe auszuwählen.

Diese Auswahl können 
Sie auch im Kontrollfeld 
Systempräferenzen > Ton > 
Ausgang vornehmen.
  

Anschluss eines Kopfhörers
Schließen Sie nun 
einen Kopfhörer an den 
Kopfhörerausgang von Duet 
an, öffnen Sie iTunes und 
starten Sie die Wiedergabe 
einer Audiodatei. Das 
Audiomaterial sollte über den 
angeschlossenen Kopfhörer 
wiedergegeben und in 
der Pegelanzeige auf der 
Oberseite von Duet angezeigt 
werden. 

4
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Kurzanleitung

Einsatz von Duet mit GarageBand 
                4.0.0 oder höher empfohlen
 

Wählen Sie in GarageBand die Option 
GarageBand > Voreinstellungen aus, klicken Sie 
auf das  Audio/Midi-Symbol und wählen Sie für 
Audio-Ausgang und Audio-Eingang den Eintrag 
Duet aus. Klicken Sie auf Erweitert-Symbol und 
stellen Sie die Audioauflösung auf Besser oder 
Beste ein.

Wählen Sie Spur > Basic Track...

Doppelklicken Sie den Header des neuen Tracks, 
um die Track-Informationen anzuzeigen. Stellen 
Sie in diesem Fenster die Eingangsquelle auf 
Mono 1 (Duet) und Monitor auf Ein.

	 Um in GarageBand das Apogee Duet -Control 
Panel zu öffnen, klicken Sie auf die Schaltfläche 
Bearbeiten         neben dem Menü Eingangsquelle.

Schließen Sie das mitgelieferte Breakout-
Kabel an den I/O-Anschluss von Duet an 
und ein Mikrofon an die    IN-1 XLR-
Buchse.

 

Tippen Sie den 
Drehregler  
mittig an, bis die IN-
1-LED leuchtet und 
drehen Sie den Regler, 
bis Sie den richtigen 
Aufnahmepegel für den 
aufnahmebereiten Track 
eingestellt haben.

	 Das Gerät ist nun für die Aufnahme bereit!

5
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Kurzanleitung

Einsatz von Duet mit  
Logic Pro/Express

	 8.0.2 oder höher empfohlen

	
Gehen Sie in das Logic Pro-Menü und 
wählen Sie Einstellungen > Audio. 
Klicken Sie auf den Reiter Geräte und 
anschließend auf den Reiter Core Audio.

	 Wählen Sie im Titel Core Audio 
aus dem Geräte-Menü den Eintrag 
Duet aus. Wählen Sie im Menü I/O-
Puffergröße 128.

	
Wählen Sie im Menü Optionen den 
Menüpunkt Audio > I/O Labels. Halten 
Sie die Wahltaste gedrückt und klicken 
Sie auf den ersten Radiobutton unter der 
Spalte I/O des Treibers. Jetzt erscheinen 
die Hardware-Label von Duet in der 
Eingangs- und Ausgangs-Auswahl Ihrer 
Logic-Session.

Um Duet direkt aus Ihrer Logic-
	 Session zu steuern, wählen Sie im 

Optionen-Menü Audio > Apogee Control 
Panel öffnen.

	 Falls Sie eine andere Core Audio-
kompatible Audiosoftware einsetzen, 
verwenden Sie die Maestro-Software 
von Apogee (die im ersten Schritt im 
Verzeichnis Anwendungen installiert 
wurde) um Duet zu steuern.

6
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Betrieb

Die Einstellungen von Duet können einfach über den Drehregler auf der Oberseite oder 
die auf Seite 10 beschriebenen Software-Control-Panels verändert werden. Aus den 
verschiedenen Optionen können Sie die Hardware- und Software-Regler wählen, die 
Ihren Bedürfnissen am ehesten enstprechen. Nutzer von Logic Pro können die Pegel 
z.B. mit dem Drehregler auf der Oberseite von Duet einstellen und Einstellungen wie die 
Eingangs-Auswahl oder Phase über das Apogee Control Panel in Logic Pro 8 auswählen. 
Viele Einstellungen können auch über mehrere Control Panel vorgenommen werden. Die 
Liste auf Seite 9 gibt einen Überblick über die Einstellungen und Funktionen, die über die 
verschiedenen Control Panel verändert werden können.

Duet-Drehregler der Oberseite
Duets Drehregler ermöglicht eine einfache und direkte Einstellung der Eingangs- und 
Ausgangspegel. 
	 Ausgangspegel

Um den Ausgangspegel (Lautstärke der Kopfhörer und Lautsprecher) von Duet 
einzustellen, drücken Sie mehrmals den Drehregler, bis die OUT-Led leuchtet. 
Drehen Sie den Regler nun, um die gewünschte Lautstärke einzustellen. Der 
Hardware-Regler arbeitet parallel zu den Software-Reglern.

	 Eingangspegel
	 Um den Eingangspegel (Aufnahmelautstärke von Mikrofonen und Instrumenten) 		
	 von Duet einzustellen, drücken Sie mehrmals den Drehregler, bis die IN1- oder 
	 IN-2-Led leuchtet. Drehen Sie den Regler nun, um die gewünschte  
	 Aufnahmelautstärke einzustellen (wird in Ihrer Recording-Software angezeigt).
	 Ausgänge stummschalten

Um die Line- und Kopfhörerausgänge gleichzeitig stummzuschalten, halten 
Sie den Drehregler gedrückt, bis die LED OUT blinkt; um die Stummschaltung 
aufzuheben, drücken und halten Sie den Regler erneut.

	 MIDI-Controller
Über den Drehregler können Sie zudem MIDI-Controller- und Song-Position-
Daten an Software-Anwendungen senden.  Einzelheiten finden Sie auf den 
Seiten 16 und 17.
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Betrieb

Duet 
Hardware 
Encoder  

Apogee 
Maestro

Apogee-
Control 
Panel 

(in Logic)

Apogee 
Duet-

Fenster in 
Garage-

Band

Audio 
MIDI-
Setup

System-
voreinstel-

lungen

Eingangs-Gain

Eingangssteuerung 
Auswahl, 48V, Grup-
pe, Phase

Ausgangssteuerung  
Dämpfung, Stumm

Ausgangssteuerung - 
Nomineller Pegel

Low-Latency-Mixer

Spezialfunktionen
                 *

MIDI-Controller

Samplerate  
(s. Seite 10)

Duet als Eingangs-/
Ausgangsgerät für 
OSX zuweisen

* alle außer Gain-Modus
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Betrieb

Apogee Maestro
Die Apogee Maestro-Software ermöglicht eine umfassende Steuerung von Duet, 
einschließlich aller Einstellungen, dem Speichern und Laden von Konfigurationen und 
Mixing mit geringer Latenz. Falls Ihre Recording-Software über kein Apogee-ControI Panel 
verfügt, verwenden Sie Apogee Maestro, um die Einstellungn vorzunehmen.

	 Maestro Low-Latency-Mixer
	 Wenn Sie bei der Aufnahme eine Verzögerung zwischen Singen oder Spielen 
	 und der Ausgabe des Sounds im Kopfhörer feststellen, kann der Mixer von 
	 Maestro Abhilfe schaffen. Weitere Informationen über den Low-Latency-Mixer 
	  finden Sie auf den Seiten 18-21.  

	 Eine ausführliche Beschreibung von Maestro finden Sie auf den Seiten 12-26.

Apogee-Control Panel (Logic Pro 8, GarageBand)
Über das Apogee-Control Panel in Apple Logic Pro 8 und GarageBand können die 
Einstellungen von Duet gesteuert und Konfigurationen gespeichert bzw. geladen werden.  
Die Control Panel dieser Programme duplizieren sämtliche im Maestro-Control Panel 
vorgenommenen Einstellungen. 

OS X-Systempräferenzen
Im Fenster Ton in den OS X-Systempräferenzen können Sie Duet für die Mac-I/Os auswählen. 
Falls Sie in Schritt 3 der Quickstart-Anleitung Duet noch nicht für die Mac-I/Os ausgewählt 
hatten, können Sie es in diesem Fenster nachholen. 
	 Gehen Sie ins Apple Menü > Systempräferenzen.
	 Klicken Sie auf das Lautsprecher-Symbol, um das Fenster Sound-Präferenzen zu öffnen.
	 Klicken Sie auf den Reiter Ausgang und wählen Sie im Geräte-Fenster den Eintrag Duet aus.
	 Klicken Sie auf den Reiter Eingang und wählen Sie im Geräte-Fenster den Eintrag Duet aus.

Audio-MIDI-Setup unter OS X
Im Audio-MIDI-Setup im Ordner Programme/Dienstprogramme können Sie die 
Samplefrequenz und den Ausgangspegel von Duet einstellen sowie Duet für die die Ein- 
und Ausgänge für OSX auswählen. Um den Ausgangspegel von Duet einzustellen und 
über AMS oder die Mac-Tastatur Kanäle stummzuschalten, wählen Sie für den Standard-
Ausgang die Option Duet.

Einstellen der Samplefrequenz
Duet kann mit allen Standard-Samplefrequenzen zwischen 44k1 und 
96k betrieben werden. In der Regel wird die Samplefrequenz von der 
Audioanwendung vorgegeben, mit der Duet interagiert. Wenn Sie z.B. mit 
GarageBand arbeiten, wird die Samplefrequenz von Duet automatisch auf 
44k1, der Samplefrequenz von GarageBand, eingestellt. Falls Sie in der 
Audioanwendung die Samplefrequenz nicht einstellen können - etwa bei  
iTunes -, steht Ihnen hierfür das Audio-Midi-Setup zur Verfügung.
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Apogee Maestro

OS X-Systempräferenzen

Das Apogee-Control Panel

Audio-MIDI-Setup unter OS X
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Maestro Control - Pegel

Interface-Menü
Wenn Duet ordnungsgemäß von Maestro erkannt wurde, wird in diesem Menü Duet 
sowie die Seriennummer des Geräts angezeigt.

Gerät identifizieren
Wenn Sie diese Schaltfläche klicken, wird die Verbindung zwischen der Maestro-
Software und Duet verifiziert, und alle LEDs auf der Oberseite leuchten. Klicken Sie die 
Schaltfläche erneut, um die LEDs wieder in den normalen Betrieb zu versetzen.
	
Eingang	
In diesem Menü wählen Sie den Eingangsanschluss und -pegel aus:

XLR Line +4dBu – Stellen Sie den Eingang auf XLR Line +4dBu, wenn Sie 
ein professionelles Line-Gerät, etwa einen professionellen Mixer, mit den  IN 
(XLR) -Anschlüssen verbunden haben.
XLR Line -10 dBV – Stellen Sie den Eingang auf XLR Line -10dBV, wenn 
Sie ein Verbraucher-Line-Gerät, etwa einen CD-Player,  
mit den  IN (XLR) -Anschlüssen verbunden haben.
XLR Mic – Stellen Sie den Eingang auf XLR Mic, wenn Sie ein Mikrofon mit 
den  IN (XLR) -Anschlüssen verbunden haben. Der Gainpegel ist variabel 
zwischen 10 and 75 dB einstellbar.
Instrument – Stellen Sie den Eingang auf Instrument, wenn Sie eine 
Gitarre oder ein Keyboard mit den  IN (1/4") -Anschlüssen verbunden 
haben. Der Gainpegel ist variabel zwischen 0 and 65 dB einstellbar. An 
diese Eingänge können auch CD-Player und andere Line-Geräte (-10 dBV) 
angeschlossen werden.

Wenn der Eingang auf XLR Mic oder Instrument eingestellt ist stehen Ihnen folgende 
Optionen zur Verfügung:

Group – Markieren Sie eine dieser beiden Optionen, um die Gain-
Einstellungen beider Eingänge zu gruppieren, so dass Sie mit dem Hardware-
Regler oder mit einem der Software-Regler den Gain-Pegel für beide 
Eingänge gleichzeitig einstellen. Wenn zwischen den Eingängen ein Gain-
Offset eingestellt wurde, wenn Sie Group aktivieren, wird dieser beibehalten. 
Input Level Software Encoder – Der Gain-Pegel der einzelnen Eingänge 
kann mit diesen Software-Reglern eingestellt werden. Der aktuelle Gain-Pegel 
wird in dem Feld rechts neben dem Regler angezeigt.
Phase-Symbol – Aktivieren Sie diese Option aktivieren, um die Polarität 
des Eingangssignals umzukehren. Wenn Sie zwei Mikrofone für eine Quelle 
verwenden, kann dies u.U. zu einem volleren Klang führen. Wenn Sie z. B. 
Mikrofone über und unter eine Snare-Drum platzieren, erhalten Sie einen 
volleren Sound, wenn die Polarität des unteren Mikrofons umgekehrt wird.
48V – Markieren Sie diese Option, um die 48 V-Phantomspannung für 
die XLR-Anschlüsse zu aktivieren. Kondensatormikrofone müssen mit 
Phantomspannung versorgt werden. 

Maestro

1

2

3

4

5

6
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Level	
Aus diesem Menü wählen Sie den Nenn- oder Durchschnittspegel der Line-
Ausgänge aus:

Line out – Stellen Sie den Pegel auf Line out, wenn Sie an die OUT-L-  
oder OUT-R-Ausgänge von Duet Aktivlautsprecher, eine HiFi-Anlage oder 
einen Mixer anschließen.
Instrument Amp – Stellen Sie den Pegel auf Instrument Amp, wenn 
Sie die OUT-L-  oder OUT-R-Ausgänge von Duet an den Eingang eines 
Verstärkers anschließen. Die Ausgangs-Lautstärke ist fest eingestellt.

Software-Regler Ausgangspegel
Der Pegel der Line- und Kopfhörerausgänge wird gleichzeitig mit diesem Software-
Regler eingestellt, wenn Level auf Line out gestellt ist. Der aktuelle Gain-Pegel 
wird in dem Feld rechts neben dem Regler angezeigt.
 
Mute	
Wenn Sie diese Option aktivieren, werden die Line- und Kopfhörerausgänge 
gleichzeitig stummgeschaltet.

7

8
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Maestro Control - Erweitert

OUT Muting – Mit diesen Kontrollkästchen legen Sie fest, welche Ausgänge 
stummgeschaltet werden, wenn Sie die Mute-Funktion aktivieren. Hier einige 

Einstellungsbeispiele:

Wenn Sie die Kontrollkästchen wie links abgebildet 
anklicken, kann zwischen einem Aufnahmemodus 
(Kopfhörer ein, Lautsprecher an den Line-Ausgängen 
aus) und einem Wiedergabemodus (Kopfhörer aus, 
Lautsprecher ein) mit einem Klick umgeschaltet werden: 
Indem Sie die Mute-Funktion ein- und ausschalten.   
Da sich beide Ausgänge einen Lautstärkeregler teilen, 
sollten Sie den eingestellten Pegel prüfen, bevor Sie das 
Muting der Line-Ausgänge wieder aufheben.

Wenn Sie die Kontrollkästchen wie hier abgebildet 
anklicken, werden die Kopfhörerausgänge nie 
stummgeschaltet. Wenn Sie Mute aktivieren, werden nur 
die Line-Ausgänge stummgeschaltet. 

Mic/Instrument gain mode – In diesem Menü stellen Sie den Eingangs-Gain- 
Modus ein:

Max. Gain range – Der gesamte Gain-Bereich steht zur Verfügung, mit 
einer Relais-Schaltung nach den ersten 10 dB Gain. 
Clickless Operation – Der Gain-Bereich ist etwas eingeschränkt, aber 
es werden keine Relais eingesetzt, so dass unabhängig von der Gain-
Einstellung ein Betrieb ohne Klicks möglich ist. Ein geeigneter Gain-Bereich 
wird auf der Grundlage der Einstellungen für Input und 48V eingestellt.

Meters Display
In diesem Menü wählen Sie das Signal, das in den Pegelanzeigen auf der 
Oberseite dargestellt wird. Folgende Einstellungen sind möglich Input, Output und 
Follow Selection. Wenn Follow Selection ausgewählt ist, folgt die Anzeige der 
Pegelanzeige auf der Oberseite: Wenn Sie  IN-1 oder IN-2 auswählen, werden beide 
Eingänge angezeigt, wenn Sie OUT wählen, wird der Stereoausgang angezeigt. 
	
Over Hold
Wenn Over Hold auf Infinite gestellt ist, werden Übersteuerungen so lange 
angezeigt, bis der Nutzer sie löscht. Um die Anzeige zurückzusetzen, klicken Sie 
auf die Over-Anzeige oder auf die Schaltfläche Clear Overs im Mixerfenster von 
Maestro. Wenn  Over Hold auf 2 Sekunden gestellt ist, werden Übersteuerungen 
nach 2 Sekunden lang angezeigt.

Maestro
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Maestro Control - Erweitert: MIDI-Controller

Number of MIDI Controllers – Um auf die MIDI-Funktionen von Duet zuzugreifen, 
aktivieren Sie in diesem Feld 1 - 4 virtuelle MIDI-Controller. Sobald einer oder 
mehrere MIDI-Controller aktiviert wurden, können sie über den Drehregler auf der 
Oberseite oder den entsprechenden Software-Regler verändert werden. Um mit 
dem Drehregler einen MIDI-Controller auszuwählen, drücken Sie den Regler bis im 
Duet-Popup der gewünschte MIDI-Controller angezeigt wird (weitere Informationen zu 
Duet-Popups finden Sie auf Seite 16.) Beachten Sie, dass keine der LEDs des Top-
Panels (IN-1, IN-2 und OUT) leuchten, wenn ein MIDI-Controller ausgewählt ist.

Wenn Number of MIDI Controllers auf 1 - 4 eingestellt ist, stehen Ihnen folgende 
Optionen zur Verfügung:

MIDI encoder – Mit diesem Software-Regler senden Sie MIDI Controller- 
oder Song Position-Daten an Audioanwendungen

Wenn im Funktions-Menü Controller ausgewählt wurde, stehen Ihnen folgende 
Optionen zur Verfügung:

Number – In diesem Feld wird die Nummer des MIDI Continuous Controller 
angezeigt.  Hier kann der gesamte Wertebereich eines 7-Bit-Controllers  
(0 - 127) eingegeben werden.
Chan – In diesem Feld wird der MIDI-Kanal angezeigt, auf dem die 
Controllerdaten gesendet werden. Sie können Kanäle 1-16 eingeben.
Value – Zahlen von 0-127 können direkt eingegeben  (und mit Enter oder 
Return) bestätigt werden; die Eingabe über den Drehregler 	 hat jedoch 
gegenüber der nummerischen Eingabe Vorrang.

Wenn im Funktions-Menü Song Position ausgewählt wurde, steht Ihnen folgende 
Option zur Verfügung:

1/4 Note – In diesem Feld wird die aktuelle Songposition in Viertelnoten ab 
Beginn des Songs (Beat 0) angezeigt.

Maestro
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Maestro

Mixen mit geringer Latenz

Um die Funktionen des Mixers von Maestro besser verstehen zu können, benötigen 
Sie u.U. etwas Hintergrundinformation zu Latenz und digitale computergestütze 
Aufnahmetechnik.

Bei der Aufnahme mit computergestützten, digitalen Audioanwendungen stört die 
Verzögerung zwischen Eingang und Ausgang des Audiosignals in der Regel das Timing 
des oder der Musiker. Diese Verzögerung oder Latenz bedeutet, dass der Musiker die 
Noten, die er spielt, erst einige Millisekunden später hört. Jeder, der schon einmal ein 
Telefongespräch mit Echo geführt hat, weiß, wie verwirrend diese kurzen Verzögerungen 
für die Kommunikation, gesprochen oder musikalisch, sein kann.

Abb. A zeigt einen typischen Signalpfad einer Vocal-Overdub-Session, um den Effekt von 
Latenz zu illustrieren. Ein Sänger singt in ein Mikrofon, das zunächst an einen A/D-Wandler 
und schließlich an die Audiosoftware zur Aufnahme geroutet wird. In der Anwendung 
wird das Live-Signal des Sängers mit dem Playback der früher aufgenommenen 
Spuren gemischt und über einen D/A-Wandler an die Kopfhörer des Sängers gesendet. 
Beide Wandler verursachen jeweils eine kurze Verzögerung und eine weitaus größere 
Verzögerung findet in der Software selbst statt, so dass der Sänger seine Performance erst 
Millisekunden später in den Kopfhörern hört. 

Abb. A

Abb. 1

Abb. 2

Abb. B

Hardware- 
Interface

Low-Latency- 
Mixer 

Aufnahme  
aktivierter Track

DAW-Ausgang

Latenz 

Latenz Latenz 

Latenz 

Audio- 
Software

Hardware- 
Interface

Aufnahme  
aktivierter Track

DAW-Ausgang

Latenz 

Latenz Latenz 

Latenz 

Audio- 
Software
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Mixen mit geringer Latenz - Fortsetzung

Indem der Hardware-Eingang direkt an den Hardware-Ausgang geroutet wird und 
in Playback zu mixen (s. Abb. B), hört dr Sänger das Monitoring-Signalmit einer viel 
geringeren Verzögerung in seinen Kopfhörern. 

Zunächst wird das aufzunehmende Signal (in diesem Fall von einem Mikrofon) direkt nach 
dem A/D-Wandler gesplittet und sowohl an die Software zur Aufnahme, als auch direkt 
an die Hardware-Ausgänge geroutet, womit die latenzlastige Software umgangen wird. 
So kann das Signal mit sehr geringer Latenz vom Mikrofon zu den Kopfhörern gesendet 
werden. Danach wird ein Stereomix der Playback-Tracks an den Low-Latency-Mixer 
geroutet und mit dem Signal an dem oder den Hardware-Eingängen zusammengelegt. 
So kann sich der Sänger selbst ohne störende Verzögerung hören, während er Playback-
Tracks zuhört, um Overdubs aufzunehmen.

Beachten Sie, dass mit dem Mixer der Software-Anwendung ein Stereo-Mix der Playback-
Tracks erstellt wird, während mit dem Low-Latency-Mixer dieser Stereo-Playback-Mix und 
das Signal an den Hardware-Eingängen gemixt wird.

Maestro

Abb. 1

Abb. 2

Abb. B
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Maestro Mixer

Mit dem Mixer von Maestro können Sie die Hardware-Eingänge von Duet mit dem 
Wiedergabesignal einer Audioanwendung mischen und den Mix an die Hardware-
Ausgänge von Duet routen. Über den Mixer von Maestro können Sie einen Monitormix 
erstellen, bei dem Latenz kein Problem darstellt.

Input 1, Input 2 – Über diese 
Kanäle können Sie das anliegende 
Signal von den Hardware-
Eingängen direkt an die Hardware-
Ausgänge von Duet routen und 
mischen. Die Eingangsquelle wird 
über die Eingangs-Einstellung 
ausgewählt (S. 12).

From Mac  - Über diesen Kanal 
können Sie das Ausgangssignal 
einer Audioanwendung an die 
Hardware-Ausgänge von Duet 
senden.  

To Hardware – Über diesen 
Kanal haben Sie Zugriff auf den 
Ausgangspegel des Mixers und das 
Routing. 
 
Wenn To Hardware auf Out 
L-R eingestellt ist, wird der 
Mixer-Ausgang an die Hardware-
Ausgänge von Duet gesendet.

Wenn To Hardware auf None 
eingestellt ist, ist der Mixer 
deaktiviert und das Ausgangssignal 
der Audioanwendung wird direkt an 
die Hardware-Ausgänge von Duet 
gesendet, ohne den Maestro-Mixer 
zu durchlaufen. 

Maestro

1

2

3

1 2 3
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Arbeiten mit dem Maestro-Mixer

Benötige ich den Maestro-Mixer?
Mit dem Mixer von Maestro können Sie einen Monitormix mit geringer Latenz erstellen. 
Wenn Sie mit Duet lediglich iTunes oder ein anderes Audioprogramm hören, benötigen Sie 
den Mixer nicht. Setzen Sie To Hardware auf None, um den Mixer zu deaktivieren.

Möglicherweise ist die Latenz in Ihrem Aufnahmesystem so gering, dass sie nicht auffällt. 
Die Latenz wird durch die Einstellung der Puffergröße bestimmt, und falls Sie einen 
leistungsfähigen Mac besitzen, können Sie die Puffergröße (und somit die Latenzzeit) 
verringern, ohne dass dadurch Störgeräusche im Audiosignal auftreten. Falls Latenz für die 
Aufnahme kein Problem darstellt, können Sie den Mixer auch deaktivieren, indem Sie To 
Hardware auf None stellen.

Einstellungen der Recording-Software
Bevor Sie den Mixer von Maestro einsetzen können, müssen einige Einstellungen in Ihrer 
Recording-Software vorgenommen werden. 
Software monitoring - Da das Signal, das Sie aufnehmen möchten, über den 
Maestr-Mixer abgehört wird, sollten die Ausgänge der aktiven Software-Spuren 
stummgeschaltet werden. Hier liegt die Ursache für eine größere Latenz. Bei den meisten 
Audioanwendungen kann das Software-Monitoring der Spure, die aufgenommen werden, 
deaktiviert werden. In Logic Pro, zum Beispiel, finden Sie diese Option in demselben 
Präferenzen-Fenster, in dem Sie Duet als Hardware-Gerät auswählen (Logic Pro > 
Präferenzen > Audio). Entfernen Sie das Häkchen vor Software-Monitoring.
Playback mix - Stellen Sie in Ihrer Recording-Software einen Mix aller Wiedergabe-Spuren 
zusammen und routen Sie ihn an die Ausgänge Out L-R. Falls die Lautstärke des Mixes mit 
einem Hauptregler eingestellt werden kann, sollten Sie ihn auf 0 dB stellen. 

Maestro-Einstellungen
Maestro-Mixer-Einstellungen - Stellen Sie die Input-, From Mac- und To Hardware-
Regler zunächst auf 0 dB. Setzen Sie To Hardware auf Out L-R.
Nachdem Sie den Eingang ausgewählt und den Gainpegel einsgestellt haben (s. S. 12), 
sollte das Signal in den Input- und To Hardware-Anzeigen erscheinen. Falls die Over-LED 
des Eingangs leuchtet, verringern Sie den Gainpegel im Maestro Control-Fenster. Falls die 
Over-LEDs unter To Hardware leuchten, verringern Sie den Eingangspegel. 
Starten Sie dann die Wiedergabe Ihrer Session. Das Wiedergabesignal sollte in den 
Anzeigen From Mac und To Hardware dargestellt werden. Stellen Sie das Verhältnis 
zwischen dem Eingangs- und dem Wiedergabesignal über die From Mac- und Input-Regler 
ein. Wenn Sie das gewünschte Verhältnis eingestellt haben, die Over-LEDs unter To 
Hardware aber noch leuchten, verringern Sie den To Hardware-Pegel. 
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Maestro

Maestro Control - Duet-Präferenzen

Die Duet-spezifischen Präferenzen von Maestro werden im Folgenden beschrieben.  
Eine Beschreibung der weiteren Präferenzen finden Sie auf Seite 24.

Launch Maestro automatically when connecting
a device (Maestro automatisch starten, wenn ein Gerät angeschlossen wird) 
Wenn Sie diese Option aktivieren, wird Maestro automatisch gestartet, wenn Duet über den 
FireWire-Bus Ihres Macs erkannt wird. Damit die Einstellungen des Maestro-Mixers nach 
einem Neustart des Computers abgerufen werden können, muss diese Option aktiviert 
sein. Andernfalls werden die Einstellungen des Maestro-Mixers nicht gespeichert, wenn Ihr 
Mac heruntergefahren oder neu gestartet wird.

Enable Duet pop-ups  (Duet-Popups aktivieren)
Wenn Sie diese Optionaktivieren, werden Regler-Popups für diverse Duet-Einstellungen im 
Mac angezeigt, darunter Eingangs- und Ausgangspegel, Input, Group und Muting.  
Zur Verdeutlichung hier einige Beispiele.

IN-1 ausgewählt,  
Input auf  XLR Mic,  
Regler auf 40 dB

IN-1 und IN-2 ausgewählt,  
Group aktiviert,  
Input 1 auf XLR Mic,  
Input 2 auf Instrument,  
Regler 1 auf 30 dB,  
Regler 2 auf 40 dB.
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Maestro

OUT-Pegel auf –12 dB 
Mute aktiviert 
OUT -Muting wie unten

Mute aktiviert 
OUT -Muting wie unten

Der Regler steuert den MIDI-Controller 1
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Maestro

Drehregler
Mouse motion – Hier stellen Sie die für die Einstellung der Drehregler erforderliche 
Mausbewegung ein.
Fine adjust key – Hier geben Sie den Tastenbefehl ein, mit dem Feineinstellungen der 
Drehregler vorgenommen werden können. 

Schieberegler
Fine adjust key - Hier geben Sie den Tastenbefehl 
ein, mit dem Feineinstellungen der Schieberegler 
vorgenommen werden können.
0db key – Hier geben Sie den Tastenbefehl ein, um 
den Schieberegler auf 0 dB zu setzen, wenn Sie in das 
Level value-Fenster klicken.
Ungroup faders - Hier geben Sie den Tastenbefehl ein, 
um eine Seite der Stereo-From Mac- und To Hardware-
Schieberegler einzustellen.

Pan-Regler
Fine adjust key – Hier geben Sie den Tastenbefehl 
ein, mit dem Feineinstellungen der Pan-Regler 
vorgenommen werden können.
Center – Hier geben Sie den Tastenbefehl ein, um den 
Pan-Regler auf 0 (Mittelstellung) zu setzen, wenn Sie in 
das Pan value-Fenster klicken.

Andere
Mute/Solo all – Hier geben Sie den Tastenbefehl ein, um Mute oder Solo für alle 
Spuren zu aktivieren, wenn Sie auf den Mute- bzw. Solo-Button klicken.

Weitere Voreinstellungen
Launch Maestro automatically when connecting a device - Wenn Sie diese Option 
aktivieren, wird Maestro automatisch gestartet, wenn Duet erkannt wird.

Maestro > About Maestro
Wenn Sie diesen Menüpunkt 
wählen, wird das rechts 
dargestellte Fenster geöffnet, das 
Information über die Software- und 
Firmwareversonen enthält. 

Alle Menüs

Maestro > Preferences
Wenn Sie diesen Menüpunkt wählen, wird das Fenster Voreinstellungen geöffnet, das 
verschiedene Optionen für die Mixersteuerung enthält.
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Maestro

Alle Menüs

Maestro > Hide Maestro
Wählen Sie diesen Menüpunkt, um die Anwendung zu verbergen.

Maestro > Hide Others 
Wählen Sie diesen Menüpunkt, um alle anderen geöffneten Anwendungen zu verbergen.

Maestro > Show All
Wenn zuvor Hide Others ausgewählt wurde, wählen Sie diesen Menüpunkt, um alle 
geöffneten Anwendungen im Finder anzuzeigen.

Maestro > Quit Maestro 
Wählen Sie diesen Menüpunkt, um die Anwendung zu verlassen.

File:
File > Open
Wählen Sie diesen Menüpunkt, um eine zuvor gespeicherte Maestro-Konfigurationsdatei 
zu öffnen.

File > Open Recent 
Wählen Sie diesen Menüpunkt, um eine kürzlich zuvor geöffnete Maestro-
Konfigurationsdatei erneut zu öffnen.

File > Close Window 
Wählen Sie diesen Menüpunkt, um das "aktive", vorderste Fenster zu schließen.

File > Save 
Wählen Sie diesen Menüpunkt, um die aktuellen Einstellungen aller Fenster zu 
speichern.

File > Save As
Wählen Sie diesen Menüpunkt, um die aktuellen Einstellungen aller Fenster in einer 
neuen Datei zu speichern.
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Window:
Window > Minimize

Wählen Sie diesen Menüpunkt, um das vorderste Fenster in das Dock zu minimieren.
Window > Zoom

Wählen Sie diesen Menüpunkt, um das aktive Maestro-Fenster zu maximieren.
Window > Bring All to Front

Wählen Sie diesen Menüpunkt, um alle Maestro-Fenster vor die geöffneten Fenster 
anderer Anwendungen zu setzen.

Tools:
Tools > Maestro Control

Wählen Sie diesen Menüpunkt, um das Maestro Control-Fenster zu öffnen.
Tools > Maestro Mixer

Wählen Sie diesen Menüpunkt, um das Routing/Mixer-Fenster zu öffnen.
Tools > Reset Symphony Clocking

In bestimmten Instanzen können Apogee-Interfaces nicht erkannt werden, bevor die 
Clock-Einstellung des ersten Interface zurückgesetzt wurde. Wählen Sie den Menüpunkt 
Reset Symphony Clocking, um die Clock-Quelle des ersten Interface auf Internal oder 
External zurückzusetzen.

Tools > Refresh Connections
Wählen Sie diesen Menüpunkt, um nach angeschlossener Apogee-Hardwarezu suchen.

Tools > Reset Mixer
Über diesen Menüpunkt können die Maestro-Mixer zurückgesetzt werden: Wählen Sie 
Reset Displayed, um den im Mixer-Fenster angezeigten Mixer zurückzusetzen oder 
Reset All, um alle Mixer zurückzusetzen.

Tools > Reset Routing
Wählen Sie diesen Menüpunkt, um die Input- und Output-Fenster auf eine "pass-
through"-Konfiguration zurückzusetzen, in der die Hardware- und Software-I/Os 1:1 
miteinander verbunden sind.

Alle Menüs
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Schließen Sie Ihre Monitore an die  

1/4”-Ausgänge mit den  Symbolen an, die 

am Breakout-Kabel mit OUT-L und OUT-R 

beschriftet sind.

Schließen Sie Ihre Kopfhörer 

an den 1/4”-Ausgang mit dem 

 Symbol an.

Anschließen Ihrer Studiogeräte an Duet

Monitore und Kopfhörer

Falls Ihre Lautsprecher 

oder Stereoeingänge mit 

Cinch-Steckern verse-

hen sind, verwenden Sie 

bitte die mitgelieferten 

Adapter. Schließen Sie 

zunächst den Adapter an 

die OUT-L und OUT-R 

-Anschlüsse des Duet-

Breakout-Kabels und 

dann das Cinch-Kabel an.
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Anschließen Ihrer Studiogeräte an Duet 

Instrument und Mikrofon

Schließen Sie Ihre Instrumente an den 

1/4”‑Eingang mit dem  Symbol 

an, das am Breakout-Kabel mit  IN-1 

beschriftet ist.

Schließen Sie Mikrofone an den 

XLR-Eingang mit dem  Symbol 

an, das am Breakout-Kabel mit IN-2 

beschriftet ist.
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Anschließen Ihrer Studiogeräte an Duet 

Instrument und Instrument

Schließen Sie Ihre Instrumente an den 

1/4”‑Eingang mit dem Symbol 

an, das am Breakout-Kabel mit 

IN-1 beschriftet ist.

Schließen Sie ein Instrument an 

den 1/4” Eingang mit dem 

 Symbol an, das am 

Breakout-Kabel mit IN-1  

beschriftet ist.
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Anschließen Ihrer Studiogeräte an Duet

Mikrofon und Mikrofon

Schließen Sie ein Mikrofon an den 

XLR-Eingang mit dem   Symbol 

an, das am Breakout-Kabel mit IN-2 

beschriftet ist.

Schließen Sie ein Mikrofon an den 

XLR-Eingang mit dem  Symbol 

an, das am Breakout-Kabel mit IN-1 

beschriftet ist.
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Anschließen Ihrer Studiogeräte an Duet

Schließen Sie Ihre Monitore an die 1/4”-
Ausgänge mit den  Symbolen an, 
die am Breakout-Kabel mit OUT-L und 
OUT-R beschriftet sind.

Aktivlautsprecher

Duet ist ideal für die Audiowiedergabe aus Ihrem Mac, sowohl für Dateien aus der  iTunes-
Library, Internet-Streams als auch für CDs und DVDs.

Um die Line-Ausgänge von Duet direkt an Aktivlautsprecher anzuschließen benötigen Sie 
zwei Kabel mit 1/4”-Klinkensteckern an einem Ende, um sie mit den OUT-L und OUT-
R-Buchsen von Duet zu verbinden, und den entsprechenden Steckern, um sie an die 
Lautsprecher anzuschließen. Duet wird mit zwei 1/4”-zu-Cinch-Adaptern geliefert, um das 
Gerät mit herkömmlichen Cinch-zu-Cinch-Kabeln an Stereoanlagen o.Ä. anzuschließen.

Wenn Sie Aktivlautsprecher anschließen, stellen Sie die Wiedergabelautstärke mit dem Duet-
Drehregler ein.
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Anschluss an eine Stereoanlage 

Wenn Sie Duet direkt an Ihre Stereoanlage anschließen möchten, schließen Sie die 
mitgelieferten 1/4”-zu-Cinch-Adapter an die OUT-L und OUT-R -Buchsen von Duet an und 
verwenden Sie ein herkömmliches Kabel mit Cinch-Steckern, um es mit dem AUX- oder CD-
Eingang Ihres Receivers zu verbinden. 

Wenn Sie Duet an eine Stereoanlage anschließen, stellen Sie die Lautstärke von Duet auf 
0 dB (volle Lautstärke) und stellen Sie die Wiedergabelautstärke mit dem Lautstärkeregler 
des Receivers ein.

Sobald Duet an Ihre Audiogeräte angeschlossen ist, verbinden Sie den FireWire-Port mit 
Ihrem Mac. Es öffnet sich das unten abgebildete Dialogfenster.  Klicken Sie Ja, um Duet für 
die Ton-Ein- und Ausgabe auszuwählen.

Diese Auswahl können Sie auch im Kontrollfeld Systempräferenzen > Ton > Ausgang 
vornehmen.

Wählen Sie in iTunes Computer für die Tonausgabe. Audiodateien, die Sie mit iTunes 
wiedergeben, werden nun an Duet geroutet, und der Ausgang ist an Ihrem Audiosystem 
verfügbar.
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Fehlerbehebung

F:  Durch  Drücken des Drehreglers ist eine Auswahl des Eingangs oder Ausgangs nicht 
möglich. Warum? 

A: Wenn die Eingänge auf XLR line oder der Ausgang auf Instrument Amp 
gesetzt ist, ist der Drehregler deaktiviert.

F: Wenn ich den Drehregler drücke, um einen Eingang oder Ausgang auszuwählen, 
erlöschen ALLE LEDs. Warum? 

A: Wenn einer oder mehrere MIDI-Regler aktiviert und zur Steuerung über den 
Drehregler auf der Oberseite ausgewählt wurden, erlöschen alle I/O-LEDs auf 
der Oberseite, um anzuzeigen, dass ein MIDI-Regler ausgewählt wurde. Wenn 
in den Maestro-Präferenzen Popups aktiviert sind, wird der ausgewählte MIDI-
Regler auf dem Bildschirm angezeigt.

F: Ich habe meine Gitarre angeschlossen, erhalte aber kein Signal. Was muss ich 
überprüfen?

A: Stellen Sie in Maestro Input auf Instrument.

F: Ich erhalte kein Signal von meinen Audioanwendungen. Was muss ich überprüfen?

A: Wenn die LED OUT blinkt, ist der Ausgang stummgeschaltet. Halten Sie den 
Drehregler auf der Oberseite gedrückt, bis die LED OUT nicht mehr blinkt. Wenn 
der Ausgang des Maestro Mixers auf Out L-R gestellt wurde, muss der From 
Mac-Fader zudem hochgezogen werden, um die Signale an den Ausgängen der 
Audioanwendung an die Ausgänge von Duet zu senden.

F:  Ich möchte, dass Maestro automatisch gestartet wird, wenn ich Duet anschließe.  
Wo stelle ich das ein?

A: Öffnen Sie Maestro > Preferences und setzen Sie ein Häkchen in das 
Kontrollkästchen Launch Maestro automatically when connecting a device.

F: Kann ich für die Kopfhörer- und Line-Ausgänge unterschiedlich Pegel einstellen?

A: Die Kopfhörer- und Line-Ausgänge werden immer gemeinsam gesteuert. 
Um das Lautstärkeverhältnis zwischen dem Kopfhörer und den angeschlossenen 
Lautsprechern zu verändern, müssen Sie die Monitorverstärker entsprechend 
einstellen. Kopfhörer- und Line-Ausgänge können unabhängig voneinander 
stummgeschaltet werden.

F: Wie stelle ich Duet auf die Werkseinstellungen zurück?

A: Um Duet zurückzusetzen, halten Sie den Drehregler 5 Sekunden lang 
gedrückt. Dadurch werden alle Parameter auf die Werkseinstellungen 
zurückgesetzt.
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Einsatz von Duet mit Apple Soundtrack Pro

Wählen Sie Soundtrack Pro > Preferences

Klicken Sie auf den Reiter Recording
Wählen Sie in den Eingangs- und Monitor-Menüs 
jeweils Duet.
Schließen Sie das Preferences-Fenster, wenn Sie 
die Einstellungen vorgenommen haben.

Einsatz von Duet mit Apple MainStage

Wählen Sie MainStage > Preferences

 

Klicken Sie auf den Reiter Audio/MIDI
Wählen Sie Duet in den Audio-Ausgangs- und Audio-
Eingangs-Menüs aus.
Setzen Sie die I/O Puffergröße auf 128
Schließen Sie das Preferences-Fenster, wenn Sie 
die Einstellungen vorgenommen haben.

Um Duet direkt aus Ihrer MainStage-Session zu 
steuern, wählen Sie MainStage > Apogee Control 
Panel öffnen.

Leitfaden für Core Audio-Anwendungen
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Einsatz von Duet mit Apple Final Cut Pro

Wählen Sie Final Cut Pro > Audio/Video Settings.

Klicken Sie auf den Reiter A/V Devices.
Wählen Sie Duet aus dem Audio-Menü aus.
Klicken Sie auf OK.

 

Einsatz von Duet mit Ableton Live

Wählen Sie Live > Preferences

Klicken Sie auf den Reiter Audio
Wählen Sie CoreAudio aus dem Driver Type-Menü 
aus.
Wählen Sie in den Menüs Audio-Eingangsgerät und 
Audio-Ausgangsgerät jeweils Duet aus.
Setzen Sie die Puffergröße auf 128.
Schließen Sie das Preferences-Fenster, wenn Sie die 
Einstellungen vorgenommen haben.

Leitfaden für Core Audio-Anwendungen
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Einsatz von Duet mit MOTU Digital Performer

Gehen Sie auf Setup > Configure Audio System > 
Configure Hardware Driver.

Wählen Sie im Fenster Configure Hardware  
Driver den Eintrag CoreAudio aus dem obersten 
Menü aus.
Wählen Sie Duet aus der Geräteliste aus.
Setzen Sie die Puffergröße auf 128.
Setzen Sie den Host Buffer Multiplier auf 1.
Setzen Sie Work Priority auf Low.
Klicken Sie auf OK.

  

Einsatz von Duet mit Steinberg Nuendo

Wählen Sie Devices > Device Setup

Klicken Sie im Devides-Fenster auf VST Audio 
System.
Wählen Sie Duet aus dem ASIO-Menü aus.

Wenn Duet von Nuendo erkannt wurde, wählen Sie 
im Devices-Fenster Duet aus.
Klicken Sie auf Control Panel.
Setzen Sie die Puffergröße im ASIO Settings-Popup-
Menü auf 128 und klicken Sie auf OK.
Klicken Sie im Device Setup-Fenster auf OK.

Leitfaden für Core Audio-Anwendungen
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Produkteigenschaften und technische Daten

Zwei Ein-und Ausgabekanäle in professioneller Audioqualität mit 24 Bit/96 kHz•	
Zwei symmetrische XLR-Eingänge, je mit zuschaltbarer 48V-Phantomspeisung•	
Max. Eingangspegel bei Einstellung +4 dBu: 20 dBu; Einstellung -10 dBV: +8 dBV•	
Mic Pre-amp-Gain: 10 bis 75 dB•	
Zwei unsymmetrische, hochohmige Instrumenteneingänge•	
Ein hochwertiger Stereo-Kopfhörerausgang•	
Zwei unsymmetrische -10 dBV Line-Ausgänge für Aktivlautsprecher•	
Multifunktions-Drehregler für Lautstärke und Gain sowie zuweisbare MIDI-Steuerung•	
Mehrstufige LED-Anzeige für Ein- und Ausgangspegel.•	
FireWire 400, kompatibel mit Mac OS X Core Audio•	
Integration und Steuerung mit GarageBand von Apple, Logic Pro, Logic Express  •	
und Final Cut Studio (Soundtrack Pro)
Kompatibel mit jeder Core Audio-fähigen Audioanwendung•	
Apogee Maestro-Software für erweiterte Steuerungsmöglichkeiten und Mixen mit •	
geringer Latenz

 
Systemanforderungen

Rechner: Macintosh G4 1GHz oder schneller, PPC oder Intel CPU� 
Speicher: 1 GB RAM (mindestens) , 2 GB (empfohlen)
OS X: 10.4.11 oder höher; OS X 10.5.3 oder höher dringend empfohlen
Anschluss: FireWire 400-Port
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Hinweise

Benutzerdaten

Die Seriennummer finden Sie auf der Rückseite des Geräts. Notieren Sie die Seriennummer in dem 
dafür vorgesehenen Feld weiter unten. Halten Sie sie bereit, wenn Sie sich an einen autorisierten 
Apogee Electronics-Reparaturfachbetrieb oder an den Hersteller wenden. Senden Sie die ausgefüllte 
Garantiekarte umgehend zurück!

Duet Seriennummer__________________________________________________________________

Kaufdatum_______________________________________________________________________

Händler____________________________________________________________________________

Telefon______________________________________________________________________________

Adresse_____________________________________________________________________________

ACHTUNG:
Vom Benutzer vorgenommene Änderungen, die nicht ausdrücklich von APOGEE ELECTRONICS 
CORPORATION genehmigt wurden, können gemäß der FCC-Bestimmungen zur Aufhebung der 
Nutzungsrechte dieses Geräts führen.

Bitte füllen Sie die beiliegende Registrierungskarte aus, um das Gerät zu registrieren oder 
registrieren Sie es online unter

http://www.apogeedigital.com/register.html 

Warnungen

FCC-Warnung
Hinweis: Dieses Gerät wurde getestet und entspricht den Bestimmungen für digitale Geräte der 
Klasse B nach Teil 15 der FCC-Bestimmungen. Diese Grenzwerte bieten angemessenen Schutz vor 
Funkstörungen beim Betrieb des Geräts in gewerblich genutzten Räumen. Dieses Gerät erzeugt und 
nutzt Hochfrequenzenergie und kann diese abstrahlen und den Funkverkehr stören, wenn es nicht 
gemäß der Betriebsanleitung installiert und betrieben wird. Der Betreib dieses Geräts in Wohngegenden 
kann schädliche Interferenzen verursachen. In diesem Fall muss der Nutzer die erforderlichen 
Maßnahmen zur Behebung dieser Interferenzen auf eigene Kosten ergreifen.

Copyright-Hinweis

Apogee Duet ist ein rechnergestütztes Gerät; als solches enthält und verwendet es im Festspeicher 
Software. Diese Software sowie die dazugehörige Dokumentation einschließlich dieses 
Benutzerhandbuchs enthält urheberrechtlich geschützte Informationen. Alle Rechte sind vorbehalten. 
Die Software oder Teile davon und die dazugehörige Dokumentation darf nicht kopiert, übertragen oder 
verändert werden. Sie dürfen die Software oder Teile davon ohne schriftliche Genehmigung der Apogee 
Electronics Corporation, U.S.A. nicht verändern, übersetzen, verleasen, vertreiben, weiterverkaufen oder 
abgeleitete Anwendungen auf der Basis dieser Software oder Teilen davon erstellen.
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Registrierung und Garantie

Bitte registrieren Sie Ihr Duet, indem Sie entweder die beigefügte Registrierungskarte ausfüllen oder 
online auf unserer Webseite: http://www.apogeedigital.com/support/. Wenn Sie Ihr Gerät registrieren, 
kann Apogee Ihnen Informationen zu Updates zukommen lassen. Sobald Verbesserungen und Upgrades 
verfügbar sind, werden Sie benachrichtigt. Firmware-Updates sind ein Jahr lang ab Kaufdatum kostenlos, 
sofern nicht anders vermerkt. Bitte wenden Sie sich mit Fragen an Ihren Händler oder an Apogee:

APOGEE ELECTRONICS CORPORATION, 
1715 Berkeley St., Santa Monica, CA  90404, USA 
Tel: (310) 584-9394
Fax: (310) 584-9385
Email: support@apogeedigital.com 
Web: http://www.apogeedigital.com

APOGEE ELECTRONICS CORPORATION garantiert, dass dieses Produkt bei normalem Gebrauch 
für zwölf Monate frei von Material- und Herstellungsfehlern ist. Diese Garantie beginnt ab dem 
Kaufdatum. Geräte, die im Rahmen der Garantieleistung an Apogee oder an einen autorisierten Apogee-
Reparaturdienst zurückgegeben wurden, werden nach Ermessen des Herstellers kostenlos repariert oder 
ersetzt. 
ALLE GERÄTE, DIE AN APOGEE ODER AN EINEN AUTORISIERTEN APOGEE-REPARATURDIENST 
ZURÜCKGEGEBEN WERDEN, MÜSSEN MIT IM VORAUS BEZAHLTEM PORTO, VERSICHERT UND 
ORDNUNGSGEMÄSS - VORZUGSWEISE IM ORIGINALKARTON - VERSENDET WERDEN. Apogee 
behält sich das Recht vor, das Design zu jeder Zeit und ohne Vorankündigung zu verändern oder zu 
verbessern. Diese Änderungen wirken nicht rückwirkend und zukünftige Änderungen des Designs 
impliziert nicht die Verfügbarkeit von Upgrades bereits vorhandener Geräte.

Diese Garantie ist unwirksam, wenn Apogee nach eigenem Ermessen befindet, dass etwaige Schäden 
aus missbräuchlicher oder nachlässiger Verwendung, Veränderung oder versuchter Reparatur durch eine 
nicht autorisierte Person zustande gekommen sind. 

Die oben aufgeführten Garantien ersetzen alle anderen ausdrücklichen oder implizierten Garantien und 
Apogee schließt die Haftung für Verkäuflichkeit oder Eignung für einen bestimmten Zweck ausdrücklich 
aus. Der Käufer nimmt zur Kenntnis und bestätigt, dass das Unternehmen in keinem Fall weder für 
spezielle oder mittelbare Schäden noch für Neben- und Folgeschäden oder für Verletzung, Verlust oder 
Schäden an Personen und/oder Eigentum, die sich aus fehlerhaftem Funktionieren dieses Produkt 
ergeben, haftbar gemacht werden kann. 

USA: Einige Bundesstaaten gestatten den Ausschluss einer implizierten Gewähr oder mittelbarer, bzw. 
von Folgeschäden nicht, so dass obige Beschränkung oder Ausschluss für Sie unter Umständen nicht 
gilt. Diese Garantiebestimmungen erteilen ihnen bestimmte Rechte: je nach Gerichtsbarkeit stehen ihnen 
unter Umständen weitere Rechte zu. 

Wartungsinformationen

Duet enthält keine Teile, die vom Benutzer gewartet werden können: Wenden Sie sich für die Reparatur 
und das Upgrade des Gerätes an qualifiziertes Fachpersonal. Die Garantie erlischt, falls Sie die 
Komponenten im Innern des Geräts manipulieren. Sollten Sie weitere Fragen haben, wenden Sie sich 
bitte an Apogee. 

Falls Ihr Duet upgraded oder repariert werden muss, setzen Sie sich mit Apogee in Verbindung, bevor 
Sie das Gerät versenden, damit Ihnen Autorisierungsnummer zur Rückgabe des Geräts erteilt werden 
kann. Diese Nummer dient Ihnen als Referenz und beschleunigt den Rücksendungsvorgang. Sendungen 
müssen im Voraus bezahlt und versichert sein, falls im Vorhinein nichts anderes ausgemacht wurde. 

WICHTIG: SENDUNGEN, DIE NICHT IM VORAUS BEZAHLT WURDEN UND SENDUNGEN OHNE 
AUTORISIERUNGSNUMMER WERDEN NICHT AKZEPTIERT. 
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Konformitätserklärungen

Dieses Gerät entspricht Teil 15 de FCC-Bestimmungen. Die Nutzung dieses Geräts unterliegt folgenden 
zwei Bedingungen: 
1.	 Dieses Gerät darf keine schädlichen Interferenzen verursachen
2. 	 Dieses Gerät muss sämtliche Interferenzen annehmen, die es erhält, einschließlich solcher, die u.U. 

einen unerwünschten Betrieb zur Folge haben.

Dieses Gerät wurde getestet und entspricht den Bestimmungen für digitale Geräte der Klasse A nach 
Teil 15 der FCC-Bestimmungen. Diese Grenzwerte bieten angemessenen Schutz vor Funkstörungen 
beim Betrieb des Geräts in einer Wohngegend. Dieses Gerät erzeugt und nutzt Hochfrequenzenergie 
und kann diese abstrahlen und den Funkverkehr stören, wenn es nicht anweisungsgemäß installiert 
und betrieben wird. Sollte dieses Gerät den Radio- und Fernsehempfang stören, was sich durch Ein- 
und Ausschalten des Geräts nachprüfen lässt, müssen Sie die Störungen durch eine oder mehrere der 
folgenden Maßnahmen beheben: 

1. 	 Richten Sie die Empfangsantenne neu aus oder verlegen Sie sie neu.
2. 	 Vergrößern Sie den Abstand zwischen Gerät und Empfänger.
3. 	 Schließen Sie das Gerät an eine andere Steckdose an, so dass Gerät und Empfänger an 

verschiedene Stromkreise angeschlossen sind.
4. 	 Fragen Sie den Händler oder einen erfahrenen Radio-/Fernsehtechniker um Rat.

HINWEIS:  Die Verwendung von nicht abgeschirmten Kabeln ist verboten.
ACHTUNG: Vom für die Zulassung verantwortlichen Hersteller nicht ausdrücklich zugelassene 
Veränderungen an diesem Gerät können die Nutzungserlaubnis des Eigentümers unwirksam machen.

Apogee Electronics Corporation, Betty Bennett, CEO.

Industry Canada Notice

This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations. Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le 
matérial brouilleur du Canada.

Konformitätserklärung — CE

Apogee Electronics Corporation erklärt hiermit, dass das Produkt Duet auf das sich diese Erklärung 
bezieht, im wesentlichen mit folgenden Normen oder anderen normativen Dokumenten übereinstimmt:

	 EN55022:1998, EN55024:1998 
	
	 EN61000-3-2, EN61000-3-3, EN61000-4-2, EN61000-4-3, EN61000-4-4, EN61000-4-5,  

EN61000-4-6, EN61000-4-8, EN61000-4-11

Declaration of Conformity – Japan

Apogee Electronics Corporation hereby declares that the Duet, to which this declaration relates, is in 
material conformity with the VCCI Class B standard.

Konformitätserklärung — Australien/Neuseeland

Apogee Electronics Corporation hereby declares that the Duet is in material conformity with AN/NZS 
standard requirements.
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